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Abstract

This exercise introduces the hardware and software used in the course. By the end of this module,
you should be comfortable with the basics of testing a simple real-time DSP system with Code Composer
Studio, the debugging environment we will be using throughout the semester. First you will connect the
laboratory equipment and test a real-time DSP system with provided code to implement an eight-tap
(eight coe�cient) �nite impulse response (FIR) �lter. With a working system available, you will then
begin to explore the debugging software used for downloading, modifying, and testing your code. Finally,
you will create a �lter in MATLAB and use test vectors to verify the DSP's output.

1 Introduction

This exercise introduces the hardware and software used in testing a simple DSP system. When you complete
it, you should be comfortable with the basics of testing a simple real-time DSP system with the debugging
environment you will use throughout the course. First, you will connect the laboratory equipment and test
a real-time DSP system with pre-written code to implement an eight-tap (eight coe�cient) �nite impulse

response (FIR) �lter. With a working system available, you will then begin to explore the debugging
software used for downloading, modifying, and testing code. Finally, exercises are included to refresh your
familiarity with MATLAB.
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2 Lab Equipment

This exercise assumes you have access to a laboratory station equipped with a Texas Instruments TMS320C549
digital signal processor chip mounted on a Spectrum Digital TMS320LC54x evaluation board. The DSP eval-
uation module should be connected to a PC running Windows and will be controlled using the PC application
Code Composer Studio, a debugger and development environment. Mounted on top of each DSP evaluation
board is a Spectrum Digital surround-sound module employing a Crystal Semiconductor CS4226 codec. This
board provides two analog input channels and six analog output channels at the CD sample rate of 44.1
kHz. The DSP board can also communicate with user code or a terminal emulator running on the PC via a
serial data interface.

In addition to the DSP board and PC, each laboratory station should also be equipped with a function
generator to provide test signals and an oscilloscope to display the processed waveforms.

2.1 Step 1: Connect cables

Use the provided BNC cables to connect the output of the function generator to input channel 1 on the DSP
evaluation board. Connect output channels 1 and 2 of the board to channels 1 and 2 of the oscilloscope.
The input and output connections for the DSP board are shown in Figure 1 (Example Hardware Setup).

Example Hardware Setup

Figure 1

Note that with this con�guration, you will have only one signal going into the DSP board and two signals
coming out. The output on channel 1 is the �ltered input signal, and the output on channel 2 is the un�ltered
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input signal. This allows you to view the raw input and �ltered output simultaneously on the oscilloscope.
Turn on the function generator and the oscilloscope.

2.2 Step 2: Log in

Use the network ID and password provided to log into the PC at your laboratory station.

3 The Development Environment

The evaluation board is controlled by the PC through the JTAG interface (XDS510PP) using the application
Code Composer Studio. This development environment allows the user to download, run, and debug code
assembled on the PC. Work through the steps below to familiarize yourself with the debugging environment
and real-time system using the provided FIR �lter code (Steps 3, 4 and 5 (Section 3.1: Step 3: Assemble
�lter code)), then verify the �lter's frequency response with the subsequent MATLAB exercises (Steps 6 and
7 (Section 3.4: Step 6: Check �lter response in MATLAB)).

3.1 Step 3: Assemble �lter code

Before you can execute and test the provided FIR �lter code, you must assemble the source �le. First, bring
up a DOS prompt window and create a new directory to hold the �les, then copy �lter.asm1 , coef1.asm2 ,
coef2.asm3 , core.asm4 , and vectcore.asm5 into your directory.

Next, make a copy of coef1.asm called "coef.asm" and assemble the �lter code by typing asm filter at
the DOS prompt. The assembling process �rst includes the FIR �lter coe�cients (stored in coef.asm) into
the assembly �le filter.asm, then compiles the result to produce an output �le containing the executable
binary code, filter.out.

3.2 Step 4: Verify �lter execution

With your �lter code assembled, double-click on the Code Composer icon to open the debugging environ-
ment. Before loading your code, you must reset the DSP board and initialize the processor mode status

register (PMST). To reset the board, select the Reset option from the Debug menu in the Code Composer
application.

Once the board is reset, select the CPU Registers option from the View menu, then select CPU Register.
This will open a sub-window at the bottom of the Code Composer application window that displays several
of the DSP registers. Look for the PMST register; it must be set to the hexadecimal value FFE0 to have the
DSP evaluation board work correctly. If it is not set correctly, change the value of the PMST register by
double-clicking on the value and making the appropriate change in the Edit Register window that comes
up.

Now, load your assembled �lter �le onto the DSP by selecting Load Program from the File menu.
Finally, reset the DSP again, and execute the code by selecting Run from the Debug menu.

The program you are running accepts input from input channel 1 and sends output waveforms to output
channels 1 and 2 (the �ltered signal and raw input, respectively). Note that the "raw input" on output channel
2 may di�er from the actual input on input channel 1, because of distortions introduced in converting the
analog input to a digital signal and then back to an analog signal. The A/D and D/A converters on the
six-channel surround board operate at a sample rate of 44.1 kHz and have an anti-aliasing �lter and an
anti-imaging �lter, respectively, that in the ideal case would eliminate frequency content above 22.05 kHz.
The converters on the six-channel board are also AC coupled and cannot pass DC signals. On the basis of

1http://cnx.org/content/m10017/2.22/�lter.asm
2http://cnx.org/content/m10017/2.22/coef1.asm
3http://cnx.org/content/m10017/2.22/coef2.asm
4http://cnx.org/content/m10017/2.22/core.asm
5http://cnx.org/content/m10017/2.22/vectcore.asm
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this information, what di�erences do you expect to see between the signals at input channel 1 and at output
channel 2?

Set the amplitude on the function generator to 1.0 V peak-to-peak and the pulse shape to sinusoidal.
Observe the frequency response of the �lter by sweeping the input signal through the relevant frequency
range. What is the relevant frequency range for a DSP system with a sample rate of 44.1 kHz?

Based on the frequency response you observe, characterize the �lter in terms of its type (e.g., low-pass,
high-pass, band-pass) and its -6 dB (half-amplitude) cuto� frequency (or frequencies). It may help to set
the trigger on channel 2 of the oscilloscope since the signal on channel 1 may go to zero.

3.3 Step 5: Re-assemble and re-run with new �lter

Once you have determined the type of �lter the DSP is implementing, you are ready to repeat the process
with a di�erent �lter by including di�erent coe�cients during the assembly process. The di�erent coe�cients
are in the �le coef2.asm. Make a copy of coef2.asm and call it coef.asm.

You can now repeat the assembly and testing process with the new �lter using the asm instruction at the
DOS prompt and repeating the steps required to execute the code discussed in Step 4 (Section 3.2: Step 4:
Verify �lter execution).

Just as you did in Step 4 (Section 3.2: Step 4: Verify �lter execution), determine the type of �lter you
are running and the �lter's -6 dB point by testing the system at various frequencies.

3.4 Step 6: Check �lter response in MATLAB

In this step, you will use MATLAB to verify the frequency response of your �lter by copying the coe�cients
from the DSP to MATLAB and displaying the magnitude of the frequency response using the MATLAB
command freqz.

The FIR �lter coe�cients included in the �le coef.asm are stored in memory on the DSP starting at
location (in hex) 0x1000, and each �lter you have assembled and run has eight coe�cients. To view the �lter
coe�cients as signed integers, select the Memory option from the View menu to bring up a Memory Window

Options box. In the appropriate �elds, set the starting address to 0x1000 and the format to 16-Bit Signed

Int. Click "OK" to open a memory window displaying the contents of the speci�ed memory locations. The
numbers along the left-hand side indicate the memory locations.

In this example, the �lter coe�cients are placed in memory in decreasing order; that is, the last coe�cient,
h [7], is at location 0x1000 and the �rst coe�cient, h [0], is stored at 0x1007.

Now that you can �nd the coe�cients in memory, you are ready to use the MATLAB command freqz

to view the �lter's response. You must create a vector in MATLAB with the �lter coe�cients to use the
freqz command. For example, if we want to view the response of the three-tap �lter with coe�cients -10,
20, -10 we can use the following commands in MATLAB:

• h = [-10, 20, -10];

• plot(abs(freqz(h)))

Note that you will have to enter eight values, the contents of memory locations 0x1000 through 0x1007,
into the coe�cient vector, h.

Does the MATLAB response compare with your experimental results? What might account for any
di�erences?

3.5 Step 7: Create new �lter in MATLAB and verify

MATLAB scripts will be made available to you to aid in code development. For example, one of these
scripts allows you to save �lter coe�cients created in MATLAB in a form that can be included as part of
the assembly process without having to type them in by hand (a very useful tool for long �lters). These
scripts may already be installed on your computer; otherwise, download the �les from the links as they are
introduced.

http://cnx.org/content/m10017/2.22/
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First, have MATLAB generate a "random" eight-tap �lter by typing h = gen_filt; at a MATLAB
prompt. Then save this vector of �lter coe�cients by typing save_coef('coef.asm',flipud(h));. Make
sure you save the �le in your own directory. (The scripts that perform these functions are available as
gen_�lt.m6 and save_coef.m7 .)

The MATLAB script will save the coe�cients of the vector h into the named �le, which in this case is
coef.asm. Note that the coe�cient vector is "�ipped" prior to being saved; this is to make the coe�cients
in h �ll DSP memory-locations 0x1000 through 0x1007 in reverse order, as before.

You may now re-assemble and re-run your new �lter code as you did in Step 5 (Section 3.3: Step 5:
Re-assemble and re-run with new �lter).

Notice when you load your new �lter that the contents of memory locations 0x1000 through 0x1007

update accordingly.

3.6 Step 8: Modify �lter coe�cients in memory

Not only can you view the contents of memory on the DSP using the debugger, you can change the contents
at any memory location simply by double-clicking on the location and making the desired change in the
pop-up window.

Change the contents of memory locations 0x1000 through 0x1007 such that the coe�cients implement a
�lter

h [n] = 8192δ (n− 4) (1)

creating a scaled and delayed version of the input. Note that the DSP interprets the integer value of
8192 as a fractional number by dividing the integer by 32,768 (the largest integer possible in a 16-bit two's
complement register). The result is an output that is delayed by four samples and scaled by a factor of 1/4.
More information on the DSP's interpretation of numbers appears in Two's Complement and Fractional
Arithmetic for 16-bit Processors.

After you have made the changes to all eight coe�cients, run your new �lter and use the oscilloscope to
measure the delay between the raw (input) and �ltered (delayed) waveforms.

What happens to the output if you change either the scaling factor or the delay value? How many seconds
long is a six-sample delay?

3.7 Step 9: Test-vector simulation

As a �nal exercise, you will �nd the output of the DSP for an input speci�ed by a test vector. Then you
will compare that output with the output of a MATLAB simulation of the same �lter processing the same
input; if the DSP implementation is correct, the two outputs should be almost identical. To do this, you will
generate a waveform in MATLAB and save it as a test vector. You will then run your DSP �lter using the
test vector as input and import the results back into MATLAB for comparison with a MATLAB simulation
of the �lter.

The �rst step in using test vectors is to generate an appropriate input signal. One way to do this is to
use the MATLAB function sweep (available as sweep.m8 ) to generate a sinusoid that sweeps across a range
of frequencies. The MATLAB function save_test_vector (available as save_test_vector.m9 can then save
the sinusoidal sweep to a �le you will later include in the DSP code.

Generate a sinusoidal sweep and save it to a DSP test-vector �le using the following MATLAB commands:

� t=sweep(0.1*pi,0.9*pi,0.25,500); % Generate a frequency sweep

� save_test_vector('testvect.asm',t); % Save the test vector

6http://cnx.org/content/m10017/2.22/gen_�lt.m
7http://cnx.org/content/m10017/2.22/save_coef.m
8http://cnx.org/content/m10017/2.22/sweep.m
9http://cnx.org/content/m10017/2.22/save_test_vector.m
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Next, use the MATLAB conv command to generate a simulated response by �ltering the sweep with the
�lter h you generated using gen_filt above. Note that this operation will yield a vector of length 507
(which is n+m− 1, where n is the length of the �lter and m is the length of the input). You should keep
only the �rst 500 elements of the resulting vector.

� out=conv(h,t) % Filter t with FIR filter h

� out=out(1:500) % Keep first 500 elements of out

Now, modify the �le filter.asm to use the alternative "test vector" core �le, vectcore.asm10 . Rather than
accepting input from the A/D converters and sending output to the D/A, this core �le takes its input from,
and saves its output to, memory on the DSP. The test vector is stored in a block of memory on the DSP
evaluation board that will not interfere with your program code or data.

note: The test vector is stored in the .etext section. See Core File: Introduction to Six-Channel
Board for TI EVM320C54 for more information on the DSP memory sections, including a memory
map.

The memory block that holds the test vector is large enough to hold a vector up to 4,000 elements long. The
test vector stores data for both channels of input and from all six channels of output.

To run your program with test vectors, you will need to modify filter.asm. The assembly source is
simply a text �le and can be edited using the editor of your preference, including WordPad, Emacs, and VI.
Replace the �rst line of the �le with two lines. Instead of:

.copy "core.asm"

use:

.copy "testvect.asm"

.copy "vectcore.asm"

Note that, as usual, the whitespace in front of the .copy directive is required.
These changes will copy in the test vector you created and use the alternative core �le. After modifying

your code, assemble it, then load and run the �le using Code Composer as before. After a few seconds,
halt the DSP (using the Halt command under the Debug menu) and verify that the DSP has halted at a
branch statement that branches to itself. In the disassembly window, the following line should be highlighted:
0000:611F F073 B 611fh.

10http://cnx.org/content/m10017/2.22/vectcore.asm
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Next, save the test output �le and load it back into MATLAB. This can be done by �rst saving 3,000
memory elements (six channels times 500 samples) starting with location 0x8000 in program memory. Do
this by choosing File->Data->Save... in Code Composer Studio, then entering the �lename output.dat
and pressing Enter. Next, enter 0x8000 in the Address �eld of the dialog box that pops up, 3000 in the
Length �eld, and choose Program from the drop-down menu next to Page. Always make sure that you use
the correct length (six times the length of the test vector) when you save your results.

Last, use the read_vector (available as read_vector.m11 ) function to read the saved result into MAT-
LAB. Do this using the following MATLAB command:

� [ch1, ch2] = read_vector('output.dat');

Now, the MATLAB vector ch1 corresponds to the �ltered version of the test signal you generated. The
MATLAB vector ch2 should be nearly identical to the test vector you generated, as it was passed from the
DSP system's input to its output unchanged.

note: Because of quantization error introduced in saving the test vector for the 16-bit memory of
the DSP, the vector ch2 will not be identical to the MATLAB generated test vector.

After loading the output of the �lter into MATLAB, compare the expected output (calculated as out
above) and the output of the �lter (in ch1 from above). This can be done graphically by simply plotting the
two curves on the same axes; for example:

� plot(out,'r'); % Plot the expected curve in red

� hold on % Plot the next plot on top of this one

� plot(ch1,'g'); % Plot the expected curve in green

� hold off

You should also ensure that the di�erence between the two outputs is near zero. This can be done by plotting
the di�erence between the two vectors:

� plot(out-ch1); % Plot error signal

You will observe that the two sequences are not exactly the same; this is due to the fact that the DSP com-
putes its response to 16 bits precision, while MATLAB uses 64-bit �oating point numbers for its arithmetic.

Note that to compare two vectors in this way, the two vectors must be exactly the same length, which is
ensured after using the MATLAB command out=out(1:500) above.

11http://cnx.org/content/m10017/2.22/read_vector.m
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